
Perusing Perimeter 
 
Intended for Grade: Fifth 
 
Subject: Math 
 
Description:  This project includes an activity in which students 
calculate the area and perimeter of various structures in Oxford, 
Mississippi.  
 
Objective:  The student will be able to calculate the perimeter and area 
of objects when provided with either images or written descriptions.  
 
Mississippi Frameworks addressed: 
 

• Math Framework 1b: Identify, classify, and find the perimeter of 
polygons. 

• Math Framework 1c: Find the area of squares and rectangles.  
• Math Framework 2f: Solve multi-step word problems using suitable 

measurements.  
• Math Framework 5i: Solve multi-step word problems using the four 

basic operations with computation and estimation. 
 
National Standards addressed: 

 
• Math Standard: Geometry 
• Math Standard: Measurement 
• Math Standard: Number and Operations 
• Math Standard: Problem Solving 

 
Materials: 
 

• Google Earth, freeware version 
• Calculators, one per student 
• Practicing Area and Perimeter worksheet 
• How Does Oxford Measure Up? worksheet (for those using the  
     Oxford, Mississippi images) 

 
Background: 
 
 Google Earth, a freeware version of which is available at 
http://earth.google.com, is a computer program that contains high-
resolution aerial or satellite photographs of most cities and towns around 

NSF North Mississippi GK-8 1

http://earth.google.com/
http://earth.google.com/


the world. The resolution of Google Earth images is so great you can even 
see the color of the cars parked in driveways! This program also contains 
a measuring tool that can be used to measure approximate lengths in 
three metric units and five standard units. 
 The length of the boundary of a two-dimensional object is called 
the perimeter. Since the perimeter of an object is a length measurement, 
students must ensure they include the length unit they use when they 
measure this boundary. For instance, the perimeter of an object can be 
48 inches, 2 feet, or 0.25 meters, but not just 36; the unit of 
measurement must be included! 

The area of a two-dimensional object is the number of 1 x 1 unit 
squares and fractions thereof contained within a given surface. To find 
the area of a square, the length (units included) is multiplied by the 
width (units included). This is why area is given in terms of square units; 
for example, 1 inch x 1 inch = 1 inch2, where the exponent on the length 
unit represents the number of times that unit was multiplied by itself to 
end up with this product. For this reason, students must understand 
that when they are calculating area they must measure the length and 
width of the object using the same length unit. The area of a rectangle or 
a square can be found by multiplying its length (units included) by its 
width (units included). The area of a triangle can by determined by 
multiplying one-half its height (units included) by its base (units 
included).  

Many students find visualizing any sort of “square unit” 
challenging. If your room is tiled with square tiles, you may try tape off a 
rectangular section of tiles. Then, students can calculate the area by 
counting the number of 1 x 1 squares that will fit inside the rectangles’s 
perimeter. You may also want to cut out several different unit squares (1 
in x 1 in, 1 ft x 1 ft, 1 cm x 1 cm, etc.) to help students visualize square 
units. Another suggestion would be to sketch a rectangle on an overhead 
transparency. After that, cut out opaque centimeter or inch unit squares, 
and the show students how the unit squares can be placed inside the 
rectangle to determine its area.   

Students may also have difficulty in calculating the area of a non-
right triangle, since in this case the height of the triangle is not the 
length of one of its sides. Students may better understand triangle area 
problems if they begin by identifying the base of the triangle. Next, have 
students locate the vertex opposite this side (the only vertex of the 
triangle to which the base the triangle is not adjacent). The height of the 
triangle is the distance from the base to this vertex. Note that this 
technique works for ALL triangles- for a right triangle, though, the length 
of the side adjacent to the base and to the above mentioned vertex is also 
the triangle’s height.  
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Procedure: 
 

1. Download the freeware version of Google Earth at 
http://earth.google.com by clicking on the “Get Google Earth (Free 
Version)” link in the upper right-hand corner. After clicking on the 
link, make sure your computer meets or exceeds the minimum 
requirements listed. If Google Earth is compatible with your 
machine, click on the “Download Google Earth.exe” button. 

2. After downloading Google Earth.exe, double click on the 
“GoogleEarth” icon (this icon looks like a globe in a cardboard box). 
Follow the installation instructions and then launch Google Earth. 

3. Enter the name of your town or city in the “Search” field in the 
upper left hand corner and then press “Enter” on your keyboard. 

4. By clicking and holding the mouse button you can “grab” and then 
move the Google Earth image. In this manner, move around your 
town or city and identify a square, triangular, or rectangular 
structure for which students will calculate the perimeter and area. 
To zoom in further, click on the “+” icon below the image. Center 
the structure in the image.  

5. Now, click on the “Tools” dropdown menu. Select the “Measure” 
function. Click on the “Line” folder tab and select the units you 
would like to use from the dropdown menu (this menu says “miles” 
but by clicking the down arrow the rest of the units appear). Note 
that ihe image cannot be moved when the “Measure” window is 
open. If you need to zoom in or out, or move the image, you must 
first close the “Measure” window.  

6. Measure the length of the structure you selected by clicking on one 
corner of the structure, releasing the mouse button, and then 
clicking on an adjacent corner of the structure. Write down this 
measured length and then repeat this procedure to measure the 
width (or height) of the structure.  

7. Close the “Measure” tool. Click on the “File” dropdown menu and 
select “Save Image.” Name this image and then save it to your 
desktop. 

8. Open this image by double clicking the corresponding icon on your 
desktop.  

a. If your machine used Microsoft Office Picture Manager to 
open this image, click on the “File” dropdown menu and 
select “Send to.” Select “Microsoft Office…” from the new 
dropdown menu. Click the “Insert into a new Microsoft Word 
document” circle. 

b. If your machine used another program to open the image, 
copy and paste the image into a Word document. 
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9. Open the Word document containing the Google Earth image. 
Open the header and label the image. 

10. Use the Microsoft Word line drawing tool to draw red lines along 
adjacent sides of the structure. For triangular structures, draw the 
red lines along the base and height. The lines you draw should be 
in the same place as the lines the “Measure” tool created. Note: If 
you cannot locate the line drawing tool, click the “Tools” dropdown 
menu and select “Customize...” Click the box next to “Drawing” 
under the “Toolbars” tab and then press the “Close” button. 

11.  Use a text box (the button that looks like an index card on the 
“Drawing” toolbar) to label the length of the structure. Open 
another text box and label the width (or height) of the structure.  

12. Save and print the labeled image. 
13. Repeat steps 3. through 12. three more times. However, use a 

different unit to measure each of the structures.  
14. Develop area and perimeter questions about each of the structures 

for students to answer. 
15. Introduce perimeter and area topics including formulae for 

squares, rectangles, and triangles. 
16. Have students complete the Practicing Perimeter and Area 

worksheet. Make sure students are including the appropriate units 
when they answer the questions on the worksheet! 

17. Divide the class into four groups. Give each group one of the 
images printed in 12.  

18. If you are using the images of Oxford, Mississippi, have students 
complete the How Does Oxford Measure Up? worksheet by 
answering the question or questions corresponding to their 
assigned image. If you are not using the images of Oxford, 
Mississippi, have students answer the questions you created in 
14. 

19. When all of the groups have completed this task, have groups 
trade images.  

20. Repeat steps 18. and 19. until each group has calculated the 
perimeter and area for all of the structures. 

 
Evaluation: 
 

Students successfully complete the Area and Perimeter worksheet 
and correctly determine the perimeter for and calculate the area of the 
structures in the printed images. 
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Extended Activities: 
 

Determine the height of various rectangular buildings in the 
images of your town. Have students then calculate the volume of these 
buildings.  
  

Using tape measures, have students measure rooms and other 
spaces in their school and calculate perimeters and areas. 
  
Sources: 
 
“Area.” Merriam-Webster Online Dictionary. Accessed 2 December 2005. 

<http://www.m-w.com/cgi-bin/dictionary> 
 
Google Earth. Accessed 1 November 2005. <http://earth.google.com> 
 
Weisstein, E. W. 1999. “Perimeter.” MathWorld. Accessed 2 December 

2005. <http://mathworld.wolfram.com/Perimeter.html> 
 
Prepared by: 
 
Nathan Holt 
NSF NMGK-8 
University of Mississippi 
December 2005 
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Image #1 
The intersection of University Avenue and Highway 7 

Oxford, MS 
 
 

605 ft. 

256 ft. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

NSF North Mississippi GK-8 6



Image #2 
Central Elementary School and Oxford Middle School 

Oxford, MS 
 
 

61 yd. 

28 yd. 
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Image #3 

The Federal Courthouse 
Oxford, MS 

 
 

 

 

67 m 

37 m 
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Image #4 
The are 

 

Oxford Squ
Oxford, MS 

0.06 mi. 

0.06 mi. 
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Name: 
Date: 
 

Practicing Area and Perimeter 
 

1. Find the perimeter and area for each of the red figures below. For 
1. e. , use the line next to the answer box to include appropriate 
units.  

 
 
a. Perimeter =  

 
 
 
Area =  

 
 
 
 
 

in. 

6 in. 

15 in. 
square in. 

b. Perimeter =  
 
 
 

Area =  
 

 
 
 
 
 

yd. 

1 yd. 

square yd. 
1 yd. 

c. Perimeter =  
 
 
 

Area = 

13 m 

5 m 

m 

  
 
 
 
 
 

 
 

square m 

12 m 
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d. Perimeter =  

 
 
 

Area = 
 
 
 
 
 
 
 
 
e. Perimeter =  

 
 
 

 Area =  
 

 
 

2.  A rectangle is five feet long and two feet wide. Answer the following 
questions about this rectangle. You may draw a picture of this 
rectangle in the space below. Be sure to include the proper 
units.  

 
a. What is the perimeter of this rectangle?  
 
 
b. What is the area of this rectangle?  

 
 
 
 
 
 
 
 
 
 
 
 

cm 

square cm 

5 cm  5 cm  

6 cm 

4 cm 

3 ft. 

3 ft. 
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Name: 
Date:  

 
How Does Oxford Measure Up? 

 
1. Use the GoogleEarth images to answer the questions below. 

 
a. Using Image #1, what is the area of the grassy triangle by 

University Avenue and Highway 7, in feet? 
 
 
 
 
 
 
 
 
 
b. Central Elementary School is the white-roofed building in 

Image #2. What is the perimeter of Central Elementary 
School, in yards?  

 
 
 
 
 
 
 
 
 

c. Using Image #2, what is the area of the first floor of Central 
Elementary School, in square yards? 
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d. The federal courthouse is the building in the center of image 

#3. What is the area of the second floor of the federal 
courthouse, in square meters? Hint: Assume that the second 
floor and the first floor have the same dimensions. 

 
 

 
 
 
 
 
 
 
 
e. Suppose Mayor Howorth wants to bulldoze the Oxford 

courthouse and then re-pave the entire square, which you 
will see in image #4. How many square miles will contractors 
repave?  

 
 
 
 
 
 
 
 

 
f. Mayor Howorth decides to keep the courthouse but to repave 

the rest of the square. If the footprint of the courthouse is 
0.0009 square miles, how many square miles will the 
contractors repave?  
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